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1 Introduction 

What is OsiMIDI T1? 

OsiMIDI T1 is an application that allows you to use USB MIDI controllers, connected directly to the 

computer, to control the Titan Go lighting software, developed by Avolites. Titan Go is installed as part of the 

Avolites Titan PC Suite package. 

In previous versions, this software was known as Titan One. For simplicity, in this manual we will always 

use the name Titan Go, although OsiMIDI T1 is compatible with both Titan Go and the old Titan One. 

Titan Go is a professional lighting control software widely used in the entertainment industry. To work 

operationally, you need to have compatible Avolites hardware, such as T1, T2, T3, or Editor Avokey. OsiMIDI 

T1 is also compatible with the Titan Mobile console starting from Titan Go version 15.1. 

The T1 device is the most economical option, although it has the limitation that the control of the 

software must be done by mouse, keyboard or touch screen. OsiMIDI T1 was born as a complement to this 

hardware, allowing you to control Titan Go with one or more MIDI controllers connected by USB to the 

computer. 

In addition, OsiMIDI T1 is also compatible with other Avolites devices such as T2, T3 and Editor Avokey. 

What do I need to set up an economical lighting control solution? 

With OsiMIDI T1 you can create a professional control solution at a low cost, consisting of: 

• The OsiMIDI T1 software. 

• Avolites hardware compatible with Titan Go (T1, T2, T3 or Editor Avokey). 

• One or more USB MIDI controllers connected to the PC, such as: Korg nanoKONTROL 2, Behringer 

BCF2000, Behringer X-Touch Compact, Elation Midicon, Akai APC Mini MK2, AKAI APC 40 MKII, 

among others. 

Why not directly use Titan Go's MIDI Triggers 

When using hardware such as T1 or Editor Avokey, Titan Go does not allow direct use of USB MIDI 

controllers, as MIDI Triggers are not enabled with this hardware. 

In the case of T2 and T3, it is possible to use the MIDI Triggers of the software, but OsiMIDI offers wider, 

more flexible and powerful control, so it is recommended even with these devices. 
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How does it work? 

OsiMIDI T1 receives the messages sent by the MIDI controller and converts them into commands to 

control Titan Go, thus allowing you to control its various elements via a physical device connected by USB. 

Main functions 

• Custom control mapping: You can freely configure which buttons, faders, and encoders on the 

MIDI controller correspond to Titan Go elements. The following can be assigned: 

o The 10 main faders. 

o Swop and Flash buttons. 

o Page navigation: Previous page, Go to page, Next page. 

o Buttons like Record, Go, Clear, Exit, etc. Nearly all buttons on the Titan Go interface are 

available for mapping. 

o Key combinations (keyboard shortcuts). OsiMIDI can send keyboard shortcuts to Titan Go 

to control functions that cannot be operated with the buttons. 

o The 3 attribute wheels. 

o Workspace window buttons: Groups, Fixtures, Colors, Position, Gobos and Beams, and 

Playbacks. 

o Macro execution. 

• Configuration editor with capture mode: Capture mode allows you to create configurations easily, 

without the need to manually enter values. Simply select a control in the interface and then 

operate the corresponding control on the MIDI device. The assignment is done automatically. 

• Management of multiple configurations: You can save different configurations and select which 

one to use at any given time. 

• Support for up to 5 simultaneous MIDI controllers, all integrated into a single configuration. 

• Support for motorized faders (since Titan Go 14): On controllers compatible with Mackie Control, 

the faders stay synchronized with those in Titan Go, even when changing pages. 

• Pickup mode (since Titan Go 14): On controllers without motorized faders, this mode prevents 

abrupt jumps in fader positions in Titan Go. The fader in Titan Go will not move until the physical 

fader matches its position. 

• Remote control from mobile or tablet, using the OsiMIDI T1 Remote app. 

• Control of MIDI controller LEDs: The LEDs of the controller's buttons mapped to workspace 

buttons automatically light up according to the state of the buttons in Titan Go. 

https://www.revers3d.com/
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• LED color customization for RGB buttons: OsiMIDI T1 allows customizing the LED colors of RGB 

buttons on the AKAI APC Mini, APC Mini MK2, APC 40, APC40 MKII and Fire controllers. 

• Early opening of MIDI devices: OsiMIDI T1 automatically opens MIDI devices when selecting a 

configuration, allowing connection errors to be detected early and preventing conflicts with other 

applications that may block access to the devices, such as Titan Go when used with T2 or T3 

interfaces. 

MIDI controller support 

Two main types of controllers can be used: 

• Controllers with Mackie Control emulation, such as the Behringer X-Touch Compact or BCF2000, 

which typically include encoders and motorized faders. 

• Generic MIDI controllers that work with the following MIDI messages: 

o Control Change or Pitch Bend for faders and potentiometer-type knobs 

o Control Change or Note On/Off for buttons 

o Control Change or Note On for encoders 

Compatible examples: Korg nanoKONTROL 2, Behringer X-Touch Compact, etc. 

For attribute wheels, two cases are considered: 

• If the controller has encoders, they can be used to control the wheels. They must operate in 

relative mode (sending different messages depending on the direction of rotation) and use Control 

Change or Note On messages. 

• If the MIDI controller does not have encoders (such as the Korg nanoKONTROL 2), 

potentiometer-type knobs or a fader can be used, combined with an auxiliary button that allows 

you to re-align the position of the physical control and continue making adjustments without 

limitations. 

Using OsiMIDI T1 with Titan Mobile 

Starting from Titan PC Suite v15.1, the Titan Mobile application was merged into Titan Go, so the Titan 

Mobile console now uses the same Titan Go application controlled by OsiMIDI T1. 

This means that OsiMIDI T1 can be used with a Titan Mobile console in the same way as with T1, T2, T3 

or Avokey Editor, since OsiMIDI T1 controls the Titan Go user interface. 

For OsiMIDI T1 to work correctly, the Virtual Hardware option in Titan Go must be configured so that 

the virtual control buttons remain visible. 

OsiMIDI T1 operates directly on the user interface, so if the virtual hardware is hidden, OsiMIDI T1 will 

not function. 

https://www.revers3d.com/
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By default, when a Titan Mobile or T3 console is connected, Titan Go automatically hides the virtual 

hardware if the option is set to Auto. In this case, OsiMIDI T1 will not work. 

To ensure compatibility: 

• Open the Titan Go application. 

• Go to System → User Settings → Display. 

• Locate the Virtual Hardware option. 

• Change it from Auto to Enabled so that the virtual hardware remains visible even when the 

Titan Mobile console is connected. 

With this configuration, the virtual controls will always remain visible, and OsiMIDI T1 will be able to interact 

normally with the Titan Go interface. 

Languages 

The language of the application and help can be changed from the application, being able to select the 

English or Spanish language. 

Supported versions of Titan Go 

OsiMIDI currently supports Titan Go from version 9.1 to 19. 

Notes 

When using a T2 or T3 interface, issues may occur if MIDI controllers without multi-client drivers are used. 

OsiMIDI does not include the Avolites Titan PC Suite software or any Avolites hardware. You must 

purchase both the software and hardware through official Avolites distributors. 

MIDI controllers are also not included and must be purchased separately. 

Avolites Titan Go and Titan One are registered trademarks of Avolites. NanoKONTROL is a registered 

trademark of Korg. BCF2000 and X-Touch Compact are registered trademarks of Behringer. Midicon is a 

registered trademark of Elation Professional. 

  

https://www.revers3d.com/
https://www.osimidi.com/t1


 https://www.revers3d.com 
https://www.osimidi.com/t1 

 

 8 

2 Installation 

To install OsiMIDI T1, the first step is to download the installer from the official website: 

http://www.osimidi.com/t1. 

Once downloaded, run the installer file. Then, select the installation language and follow the steps in the 

wizard until the process is complete. 

 

 

https://www.revers3d.com/
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The installation creates a desktop shortcut with the following icon:  

 

OsiMIDI for Titan One 
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3 Software activation 

When you start OsiMIDI T1 for the first time, the activation window will be displayed: 

 

At the bottom-left corner, you’ll find the  and  buttons to switch the language of the window 

between Spanish and English. 

3.1 Activate using a serial number 

If you have a serial number, you can activate the application by clicking on the "Activate using a serial 

number" button: 

 

The activation dialog will then open, where you must enter your serial number and click on the 

"Activate license" button: 

 

An internet connection is required to activate the software. 

https://www.revers3d.com/
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3.2 Test in demo mode 

If you want to evaluate the application before purchasing a license, you can activate it in demo mode, 

which allows you to use OsiMIDI T1 for free for 30 days. 

The only limitation of demo mode is that the application will automatically disconnect from Titan Go 

after 5 minutes of use. You will then need to wait 1 minute before reconnecting. 

To activate demo mode, click the “Try in demo mode for 30 days” button: 

 

An internet connection is required to activate demo mode. 

Once the 30-day trial period has ended, a license will be required to continue using the software. 

3.3 Buy OsiMIDI T1 

To purchase a license, you can visit the official product website: 

https://www.osimidi.com/t1. 

You can navigate to the product website by typing the URL into your browser, or by clicking the “Buy 

OsiMIDI T1” button: 

 

Once on the website, go to the "Pricing" section from the top menu. There, you can start the purchase 

process for both individual licenses and license packs. 

License packs allow you to purchase multiple licenses in a single order, with a reduced price per unit. 

The more licenses included in the pack, the greater the discount applied. 

https://www.revers3d.com/
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4 Application user interface 

4.1 Launching the application 

To launch OsiMIDI T1, use the shortcut created during the installation process: 

 

OsiMIDI T1 

It is important to connect your MIDI controllers to the computer before opening the application, as 

OsiMIDI T1 detects them during startup. 

4.2 Main window 

Once the application has started, the main window of OsiMIDI T1 will be displayed: 

 

Once the application has started, the main window of OsiMIDI T1 will be displayed: 

In the “Configuration” dropdown, you can select the configuration you want to use from those 

previously created using the application's configuration editor. This dropdown shows the user-defined 

configurations. 

When a configuration is selected, the “MIDI Controllers” group of controls will appear, displaying one 

row for each controller defined in that configuration. 

https://www.revers3d.com/
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Each row includes: 

• The name assigned to the MIDI controller when the configuration was created. 

• A dropdown where you must select the corresponding MIDI device. 

If the MIDI device name matches the original configuration, it will be selected automatically. Keep in 

mind that Windows may change the name of a USB MIDI device if it is connected to a different port or if the 

driver is updated. 

Below is an example of the main window with a configuration selected that includes two MIDI 

controllers: 

 

The “Enable pickup mode” option allows you to activate this functionality, which is explained in more 

detail in the next section. 

Once all options are selected, you can click the “Start” button to begin controlling Titan Go with the 

MIDI controllers. OsiMIDI T1 will listen to the MIDI messages sent by the controllers and perform the 

corresponding actions in Titan Go. 

To ensure OsiMIDI T1 works correctly, Titan Go must already be running and the show fully loaded 

before clicking “Start”. 

The “Stop” button allows you to stop controlling Titan Go. 

4.3 Pickup mode 

This option enables pickup mode, designed for controllers that do not have motorized faders. 

https://www.revers3d.com/
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Typically, controllers that emulate Mackie Control do include motorized faders, so this option is only 

useful with standard MIDI controllers, such as the Korg nanoKONTROL or similar devices. 

When using controllers without motorized faders, the position of the faders on the MIDI controller may 

not match the position of the faders in Titan Go — for example, when switching pages or when the faders are 

moved directly in Titan Go using the mouse. 

Pickup mode prevents abrupt changes in Titan Go fader positions when moving the faders on the MIDI 

controller. 

OsiMIDI T1 compares the positions of the faders and does not send any changes to Titan Go until the 

MIDI controller fader reaches the same position as the one in Titan Go. Once both positions are matched, 

control becomes continuous and accurate again. 

This functionality is only available starting from Titan Go version 14. 

4.4 "Archive" menu 

The following image shows the application's “File” menu: 

 

When this menu is opened, it includes the “Exit” command, which allows you to close the application. 

4.5 Configuration editor 

Before using OsiMIDI T1, you need to configure the application to map the faders, knobs, and buttons 

of the MIDI controllers to the faders, wheels, and buttons available in Titan Go. 

To do this, the OsiMIDI T1 configuration editor is used. Although it is possible to enter values manually 

in edit mode, the easiest way to create a configuration is by using capture mode. 

In this mode, you simply select a control in the editor and then operate the corresponding physical 

element on one of the MIDI controllers (for example, moving a fader or pressing a button). The editor 

automatically detects the MIDI message data and assigns it to the selected control in the application. 

The following sections describe the different functions of the configuration editor in detail. 

4.5.1 Opening the configuration editor 

To open the configuration editor, use the "Open configuration editor" command.  

https://www.revers3d.com/
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The following image shows the main window of the editor: 

 

The main window of the configuration editor is divided into five areas: 

1. Window title. 

2. File menu, where you can: 

• Create a new configuration. 

• Open an existing configuration for editing. 

• Import and export configurations. 

3. Ribbon with commands for editing the configuration. 

4. Main area, where the current configuration is displayed, including the MIDI values mapped to each 

control. 

5. Status bar, visible only when a configuration is open. It displays informational messages about the 

editor’s usage, as well as warnings and errors. 

1 

 

2 

 

4 

3 

 

 5 
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4.5.2 Window title 

The title of the configuration editor window displays the following information: 

- The name of the product: OsiMIDI T1. 

- The version of the application. 

- The name of the setting currently under edit, enclosed in square brackets. 

- If you make changes to the settings and haven't saved them, an asterisk (*) is displayed at the end 

of the title. This asterisk disappears when you save your changes. 

4.5.3 "File" menu 

The following image shows the "File" menu in the configuration editor: 

 

From this menu, you can: 

• Create a new configuration. 

• Open an existing configuration for editing. 

• Import and export configurations. 

4.5.4 New configuration 

You can create as many configurations as you need. For example, if you use several models of MIDI 

controllers, you can create separate configurations for each one or create configurations that combine 

multiple controllers. 

To create a new configuration, click the  button available in the “File” menu. 

The following dialog will appear: 

https://www.revers3d.com/
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In the “Name” field, enter the desired name for the configuration. The name must be unique: you 

cannot create two configurations with the same name. 

Below the name field, in the left column of the dialog, you’ll find the “Devices” section, which displays 

a list of the MIDI controllers included in the configuration. 

In the “Number of controllers” field, define how many controllers will be part of the configuration 

(between 1 and 5). 

For each controller, select its entry in the list and configure its properties in the right panel, “Properties 

of MIDI controller”: 

• Name: A custom name to identify the controller. 

• Model: Select the controller model from the list. If the MIDI controller is not listes, select a 

generic model using the following criteria: 

o Select “Mackie Control Controller” if the MIDI controller supports Mackie Control 

emulation. You must enable Mackie Control emulation on the controller. 

o Select “MIDI Controller” if the MIDI controller does not support Mackie Control 

emulation. 

• Input and output device: Select the corresponding input and output device for the selected 

controller. 

https://www.revers3d.com/
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• Motorized faders: Available from Titan Go 14 onward. If using a Mackie Control-compatible 

controller with motorized faders and this option is enabled, the fader positions on the MIDI 

controller will stay in sync with the faders in Titan Go, even when switching pages. 

• Ignore channel: This option is only available when the “MIDI Controller” model is selected. If 

enabled, MIDI message channels will be ignored. This option is for backward compatibility 

with configurations created using OsiMIDI T1 version 1.8 or earlier. It’s generally 

recommended to leave it disabled, as some controllers require channel data to function 

properly. 

• Operating mode: Korg nanoKONTROL 2 and nanoPAD 2 controllers can operate in two modes, 

native mode and normal mode: 

o In native mode, controller setup is easier, as it uses manufacturer-preset messages 

that work seamlessly with OsiMIDI T1. However, in this mode, it is not possible to use 

the controller’s scenes. 

o In normal mode, you can configure the controller’s messages using the Korg KONTROL 

Editor software, and scenes are available. 

Unless you specifically need to use MIDI controller scenes, native mode is recommended. 

• Color: Automatically assigned. This color identifies the controller in the configuration editor’s 

main area. 

You can reduce the number of controllers by adjusting the “Number of MIDI controllers” field or 

remove a specific controller using the “Delete MIDI controller” button. 

Once you accept the dialog, the new configuration will appear in the editor’s main area, ready to be 

edited. Its name will appear in the application title bar. 

4.5.4.1 Controller Colors 

Each controller in the configuration is automatically assigned a color. The corresponding color for 

each controller is shown in the new configuration window. 

These colors are later used in the configuration editor to identify which MIDI controller each function 

has been mapped to. 

The following image shows the new configuration dialog with the maximum number of controllers, 

allowing you to see the color palette in use: 

https://www.revers3d.com/
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4.5.4.2 Enable connection with the OsiMIDI T1 Remote app 

The OsiMIDI T1 Remote app, available for iOS and Android, allows you to control OsiMIDI T1 from a 

mobile device. 

To enable this connection, check the option "Enable connection to the OsiMIDI T1 Remote app". 
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You also need to set a listening port. The default value is 14415, both in the application and in the 

mobile app. In most cases, it is not necessary to change this unless the port is already being used by another 

application. If you do change it, make sure to set the same value in the mobile app. 

Communication between OsiMIDI T1 and the app is done via the OSC protocol. 

4.5.4.3 Enable connection with other OSC applications 

OsiMIDI T1 also allows connection with third-party applications that support the OSC protocol. 

To do this, enable the option "Enable OSC for other applications". 

 

You must add at least one OSC target, which defines the IP address and listening port of the third-

party OSC application. This allows OsiMIDI to send OSC messages to the configured targets, for example, when 

a fader is moved in Titan Go or from a MIDI controller. 

To create an OSC target, click the  button. The following dialog will appear, where 

you can enter the IP address, port, and a description for the OSC destination. 

https://www.revers3d.com/
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Once created, the destination will appear in the list. 

 

The  and  buttons allow you to edit or delete an existing OSC target. 

Once the configuration has been created, the OSC addresses of each control will be visible in the 

configuration editor, in the device’s “OSC server” tab. 
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4.5.5 Open configuration 

To open an existing configuration, click the  button available in the “File” 

menu. 

A dialog will appear allowing you to select one of the saved configurations. Once confirmed, the 

selected configuration will be displayed in the main area of the configuration editor, where it can be edited. 

The configuration name will be shown in the title of the application window. 

 

 If no configuration has been created yet, an informational message will be displayed offering the 

option to create a new configuration. 
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4.5.6 Export Settings 

The  button in the “File” menu allows you to export one or more 

configurations to a file. This file can later be imported on the same computer or on a different one using the 

import configuration function. 

When you click the button, an initial dialog will appear allowing you to select which configurations you 

want to export from the existing ones: 

 

Once confirmed, a second dialog will open where you must specify the location and name of the export 

file. After confirmation, a file with the .export extension will be generated, containing the selected 

configurations. 

4.5.7 Import configuration 

The  button in the “File” menu allows you to import configurations that were 

previously exported to a file. 

When you click the button, an initial dialog will appear where you must select the export file. Then, a 

second dialog will open where you can choose which configurations from the file you want to import. 

https://www.revers3d.com/
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4.5.8 Exit 

The last button in the “File” menu allows you to close the configuration editor. 

If there is a configuration being edited with unsaved changes, a warning message will appear indicating 

that changes will be lost if you proceed. The message will offer the option to save the configuration, cancel 

the operation, or exit without saving. 

 

4.5.9 Configuration editing 

Once a configuration is loaded, it is displayed in the main area of the configuration editor: 

https://www.revers3d.com/
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The ribbon buttons allow you to edit the loaded configuration. 

The configuration is organized into six main tabs: “Faders”, “Buttons”, “Keyboard shortcuts”, 

“Wheels”, “Workspaces”, and “Macros”. 

Each tab contains controls that represent functions of the Titan Go software, which are mapped to 

physical controls (buttons, faders, knobs) on the MIDI controllers. 

These tabs are further grouped under device-specific tabs, as a function can be mapped 

simultaneously on more than one MIDI controller. 

4.5.9.1 Device tabs 

Device tabs are shown using the color assigned to each MIDI controller in the configuration. 

 

Each configuration control can be mapped to one or more devices simultaneously. In the lower-right 

corner of each control, one or more colored rectangles are displayed that indicate which devices the control 

is mapped to (the color corresponds to the color of the device). The following image shows a button mapped 

to two devices: 
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The border color around the control indicates which device the displayed values belong to. 

In Simulation and Capture modes, if a control is mapped to a single device, its values are shown, and 

the control border is highlighted in the assigned color. If the control is mapped to multiple devices, the 

displayed values and border color will correspond to the device currently selected in the device tab. You can 

switch tabs to view the data for another device. 

 

In Edit mode, only the device mappings for the selected tab are displayed. This allows you to add 

mappings specific to that device using the "Edit Values" feature. 

4.5.9.2 Faders 

This tab allows you to map the faders from Titan Go, as well as the Swop and Flash buttons. It also 

lets you map the page navigation buttons: Page Down, Goto Page, and Page Up. 
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4.5.9.3 Buttons 

This tab allows you to map additional buttons from Titan Go. 
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4.5.9.4 Keyboard shortcuts 

OsiMIDI T1 allows you to send keyboard shortcuts to Titan Go, providing access to additional 

functions not available via buttons. In terms of configuration, keyboard shortcuts behave exactly like buttons. 

The only difference is that when using a shortcut, OsiMIDI T1 will send a key press to Titan Go instead of 

clicking a button. 
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4.5.9.5 Wheels 

OsiMIDI T1 allows you to control the three attribute wheels in Titan Go: 

 

In the “Wheels” tab, you'll find three groups of controls, each corresponding to one of the wheels. 

Each group includes a dropdown menu to select the control mode for that wheel. Two options are available: 

• Knob encoder (Relative): Recommended if your USB MIDI controller has encoders. Encoders 

can rotate infinitely, making control more convenient. 

• Potentiometer knob / Fader (Absolute): Use this mode if your USB MIDI controller does not 

have encoders. In this case, you can use a potentiometer knob or a fader, along with an 

auxiliary button that allows the position to be recovered when the end of the physical control 

path is reached, avoiding unwanted movements in the opposite direction. 

4.5.9.5.1 Knob encoder mode (Relative). 

This mode is intended for controllers with encoders set to relative mode. 

Encoders in relative mode send MIDI messages repeatedly as they rotate. The message differs 

depending on the direction of rotation (left or right). OsiMIDI T1 supports both Control Change and Note On 

messages for encoders. 
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Examples: 

• The Behringer BCF2000 controller must be configured to send Control Change messages in 

Relative 1 mode. 

• The Elation Midicon controller sends Note On messages, so it is also compatible. 

Each wheel group includes two virtual buttons: Left and Right. These buttons do not physically exist 

on your controller; they are used within the editor to represent the encoder and configure the MIDI messages 

your controller sends when turning left or right. As with any other control, you can configure these messages 

manually or using Capture mode. 

 

To configure an encoder using capture mode: 

• Click the Left button for the corresponding wheel. 

• Turn the encoder to the left: the MIDI message will be captured automatically. 

• Click the Right button. 

• Turn the encoder to the right: the MIDI message will also be captured. 

Repeat this process for the remaining wheels. 

4.5.9.5.2 Potentiometer knob / Fader mode (Absolute) 

If your controller does not have encoders, you can still control the wheels using potentiometer-

type knobs or faders. 

Since these controls have a limited range, an additional button called “Wheels disable” is required. 

This button prevents the wheel from turning while you reposition the physical control. 

How it works: 

• If you reach the end of the knob or fader but want the wheel to continue turning, press the 

Wheels disable button and move the control in the opposite direction to recover position. 

• While the button is pressed, the wheel does not rotate. 
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• Once the knob or fader is repositioned, release the button and continue turning the wheel 

as desired. 

 

To configure the wheels in this mode: 

• Map the Wheels disable button. 

• Map the knob or fader that will control each wheel. 

4.5.9.5.3 Control wheels 1 and 2 with XY Pad (Pan and Tilt) 

If your controller has an XY Pad, you can use it to control wheels 1 and 2 simultaneously, which is 

especially useful for managing Pan and Tilt. 

The easiest way to configure this is with Capture mode, which provides two buttons: 

• Capture values: Launches a configuration wizard for the XY Pad. 

• Clear values: Deletes the current XY Pad configuration. 

 

During the wizard, you will be prompted to press the corners of the XY Pad. If you're using a 

nanoPAD2 in native mode, pressing just one corner is enough, since its messages are predefined by the 

manufacturer. 
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4.5.9.5.4 Wheel sensitivity adjustment 

OsiMIDI T1 does not include internal wheel sensitivity settings, as this adjustment can be made 

directly in Titan Go: Avo \ User Settings \ Wheels \ Wheels sensitivity. 

 

Make sure not to leave the Avo button pressed accidentally, as this will cause the wheels to operate 

at maximum sensitivity at all times. 

4.5.9.6 Workspaces 

OsiMIDI T1 allows you to control the first 100 buttons in the following Titan Go workspace windows: 

Groups, Fixtures, Colors, Position, Gobos and Beams, and Playbacks. 
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4.5.9.7 Macros 

OsiMIDI T1 allows you to map macros to MIDI controller buttons using the “Macros” tab. 

The number of each button in this tab directly indicates the macro number that will be executed 

when the corresponding button on the MIDI controller is pressed. 

This works the same as performing the following steps manually in Titan Go: pressing the “Macro” 

button, entering the macro number using the keyboard, and pressing the “Enter” key. 

 

4.5.9.8 LEDs 

OsiMIDI T1 allows you to control the LEDs of the MIDI controller buttons that are mapped to 

workspace buttons in Titan Go. This feature is compatible with any MIDI controller that includes LED lighting 

in its buttons. 

The default behavior is as follows: 

If a workspace button is selected in Titan Go, the LED of the MIDI controller button that is mapped 

to it will turn on. 

If the button is not selected, the LED remains off. 
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This LED control is automatic and requires no additional configuration. It applies to any mapped 

button with an LED, regardless of the MIDI controller model. 

4.5.9.8.1 Leds tab 

For the AKAI APC Mini MK2, AKAI APC Mini, AKAI APC 40 AKAI APC40 MKII and AKAI Fire controllers, 

which feature RGB backlit pads, OsiMIDI T1 provides an additional feature that allows users to customize the 

pad colors through the "LEDs" tab, only visible for these specific controllers. 

This tab displays a visual layout of the controller, with all pads shown in green by default. The 

following image shows the LEDs tab for the AKAI APC40 MKII: 

 

Users can customize the LED color of each pad: 

• By clicking on a pad in the layout. 

• A dialog will open, allowing the user to select the desired color. 
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The behavior of the RGB pads is as follows: 

• By default, pads remain continuously lit in the selected color. 

• When the workspace button mapped to a specific pad is selected in Titan Go, the pad will 

blink in the configured color. 

This behavior takes advantage of the RGB capabilities of these AKAI controllers to provide a clear 

visual indication of the state of the mapped workspace buttons. 

The following image shows an example where several RGB button colors have been customized: 
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4.5.10 Edit configuration 

The  button allows you to edit the general settings of the configuration: its name and the 

MIDI controllers it includes. 

Clicking this button opens the configuration editing dialog, which is the same dialog used when 

creating a new configuration. 

If you change the "Ignore channel" option for a controller that is already configured, all values 

associated with that controller in the configuration will be deleted. This option is always disabled when 

selecting a Mackie Control emulation model. 
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4.5.11 Erase configuracion values 

The  button lets you remove all data from the currently loaded configuration, 

resetting it to a blank state as if it had just been created. 

A confirmation message will be shown before the operation is carried out: 

 

4.5.12 Delete configuration 

To delete a configuration, you must first open it. Once opened, click the  button to delete 

it. 

A confirmation prompt will appear before completing the operation: 

 

  

https://www.revers3d.com/
https://www.osimidi.com/t1


 https://www.revers3d.com 
https://www.osimidi.com/t1 

 

 41 

4.5.13 Configurator working modes 

The configuration editor has three working modes: Simulation mode, capture mode, and edit mode. 

You can switch between them by clicking the corresponding button in the ribbon. 

4.5.13.1 Edit mode  

To activate edit mode, click the  button. This mode allows you to manually edit mapping values 

by defining the MIDI messages for each function. 

In this mode, you can select controls in the main area by clicking on them. When a control is selected, 

it is highlighted in blue, as shown in the following image: 

 

Once a control is selected, the  and  buttons become available, allowing you to edit or 

delete the mapping values of the selected control. 
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Clicking the  button opens the following editing dialog, where you can manually enter the 

mapping values for the control: 

 

The MIDI controller field is not editable, as it corresponds to the MIDI controller of the currently 

selected device tab. 

The values for address, off value, on value, and note must always be entered in hexadecimal format. 

Once entered, the values will appear inside the corresponding control. Additionally, the control's 

border will be displayed using the color assigned to the controller. The left border is thicker to make the 

controller's color more visible. 

 

The information displayed inside the control, from top to bottom, is as follows: 

• Message type, in black: CC (Control Change), PB (Pitch Bend), NOO (Note On / Off) 

• Channel, in red 

• Address or note, in brown 

• Off value, in green 

• On value, in blue 
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4.5.13.2 Capture mode 

Capture Mode is activated by clicking the  button . It is the preferred mode for mapping the 

various controls in a configuration. 

In Capture Mode, you don’t need to manually enter values. Simply select a control in the workspace 

area, then operate the corresponding control on your MIDI controller. The configuration editor will 

automatically capture all the values from the MIDI message. 

The capture process varies depending on the type of control: 

• Button: Press the button on the MIDI controller. 

• Fader: Move the fader all the way down, then all the way up. It’s important to repeat this 

motion several times to ensure that OsiMIDI correctly captures the MIDI values for both the 

minimum and maximum positions. 

• Knob: Mapping varies depending on whether it’s an encoder (relative) or a potentiometer 

(absolute): 

o Encoder (relative): Appears in the editor as two buttons. To map an encoder, select 

the left button and turn the encoder slowly to the left. Then select the right button 

and turn the encoder slowly to the right. Moving the encoder slowly is important, as 

some MIDI controllers encode rotation speed in the MIDI values sent. 

 

o Potentiometer (absolute): Turn the potentiometer fully to the left, then fully to the 

right. It’s important to repeat this movement several times to ensure OsiMIDI 

correctly captures the MIDI values for both ends of the range. 

 

4.5.13.3 Simulation mode 

Simulation mode is the default mode when creating or opening a configuration. 
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If you are in another mode, you can return to simulation mode by clicking the  button. 

In this mode, configuration values cannot be edited. Its purpose is to verify that the mappings are 

correct. 

In simulation mode: 

• If you press a button on the MIDI controller, the corresponding mapped button in the 

configuration will be highlighted in the application. 

• If you move a fader on the controller, the corresponding fader in the application will move. 

• If you turn a knob on the controller, the corresponding knob in the application will turn as 

well. 

Additionally, when a control on the MIDI controller is used, the configuration tab and the 

corresponding device tab that contain that control will automatically be selected, making it easier to locate. 

4.5.14 Save 

At any time, you can save the changes made to a configuration by clicking the  button . 

When there are unsaved changes, an asterisk (*) will appear to the right of the window title. 

When saving: 

• It will be verified that multiple controls are not mapped to the same MIDI message. 

• If duplicate mappings are detected, an error message will appear indicating that the 

configuration cannot be saved. The user must assign unique mappings to all controls before 

saving. 

• Controls with mapping conflicts will be highlighted in red. 

Additionally: 

Configuration errors will be displayed in the status bar at the bottom of the window. 

The “Go to the next error” button allows you to navigate between controls with errors, making them 

easier to locate. 

Devices with mapping errors will also display an error icon in the corresponding device tab. 
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4.6 Early opening of MIDI devices 

When a configuration is selected, OsiMIDI T1 immediately attempts to open the configured MIDI 

devices, instead of waiting for the user to click the Start button. An OK or ERROR label is displayed next to each 

input and output device, indicating whether it was successfully opened. 

The user can change the MIDI devices at any time using the input and output device dropdown lists, or 

by selecting a different configuration. If any device is changed, OsiMIDI will automatically close the previous 

device and open the new one, updating the connection status on screen. 

This early opening ensures that OsiMIDI has control of the devices from the start, especially when using 

other applications that may access MIDI devices, including Titan Go when used with T2 or T3 interfaces, since 

in this case Titan Go automatically opens all available MIDI devices. 

This is particularly useful for MIDI devices that use Windows MIDI drivers, as these are not multi-client. 

In contrast, with MIDI controllers that have multi-client drivers, devices can be opened simultaneously from 

more than one application, so this problem does not occur. 
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4.7 Language selection 

You can change the application language from the Language tab in the ribbon, by clicking the button 

corresponding to the desired language: 

 

The available languages are Spanish and English. 

When a language is selected, both the application interface and the user manual will switch to that 

language. 

4.8 Activating the application from demo mode 

If you are using OsiMIDI T1 in demo mode and have purchased a license, you can activate it using the 

 button available in the Help tab. 

In the screen that opens, enter the serial number in the text box and click the Activate license button. 

 

 

 

An internet connection is required to activate the license. 

4.8.1 Return license to server 

A serial number allows OsiMIDI T1 to be activated on a single computer at a time. Once OsiMIDI T1 

has been activated with a serial number, it is not possible to use that same license simultaneously on another 

computer. 
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If you wish to use OsiMIDI T1 on more than one computer at the same time, you will need to purchase 

additional licenses. 

However, you can transfer the license from one computer to another. To do this, you must return the 

license to the server from the computer where it is currently active, which will then allow the serial number 

to be used on another computer. 

To return the license, go to the license screen and click the “Return license to server” button: 

 

This screen shows that the application is registered, along with the serial number. 

 

Once the license has been returned to the server, the application will close automatically, and the 

license will be released for use on another computer. 

An internet connection is required to return the license to the server. 

4.9 Manual 

The  button located in the “Help” tab opens the user manual. 
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4.10 Demo mode 

When using the application in demo mode, you have a trial period of up to 30 days. 

In the main window, an information message is displayed showing the number of days remaining in 

demo mode. It also indicates that, during this mode, the application will disconnect from Titan Go after 5 

minutes of use, and you will need to wait 1 minute before reconnecting. 
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5 Requirements 

OsiMIDI T1 is compatible with Windows operating systems from version 7 to 11. 

OsiMIDI T1 is compatible with Titan Go from version 9.1 to 19. 

6 Customer Support 

OsiMIDI T1 is software developed by REVERS3D Software SL. 

If you need support, you can contact us through the following channels: 

• Email: info@osimidi.com 

• Contact form: https://www.osimidi.com/t1 

• Facebook page: https://www.facebook.com/OsiMIDI/ 
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